Imagine 3 lice of mp
ol

WA ) g

YP-K3J



Pour votre sécurité

A AVERTISSEMENT

instructions.

Lisez attentivement ce manuel afin d'utiliser cet appareil
correctement et d'éviter tout danger ou dommage matériel.

Vous risquez de vous blesser griévement si vous ne suivez pas ces

Utilisation de I'appareil

L Ne pas démonter, réparer
8 ou modifier cet appareil
vous-méme.

Ne mouillez pas I'appareil
et ne le laissez pas tomber
dans Il'eau.

Si l'appareil est mouillé, ne I'al-
lumez pas. Contactez un centre
de dépannage.

Ne posez pas |'appareil
dans un endroit humide,
poussiéreux ou couvert de
suie, ce qui pourrait
provoquer un incendie ou
une décharge électrique.

Ne laissez pas I'appareil
dans un lieu ot la tempéra-
ture excede 35 °C (95 °F) (ex
: sauna ou stationnement).
En été, la température a
l'intérieur d'une voiture peut
atteindre 80°C (176 °F).

Dun

Ne touchez jamais le
chargeur si vous avez les
mains mouillées.

Pour éviter les troubles auditifs

L'utilisation prolongée de I'écouteur ou du casque
peut fortement réduire votre acuité auditive.

Si vous vous exposez a un volume sonore supérieur a 85
dB pendant une durée prolongée, votre ouie sera
irémédiablement endommagée. Plus le son est élevé,
plus votre acuité auditive diminue (une conversation
ordinaire a un niveau sonore compris entre 50 et 60 dB
alors que celui provenant d'une route est d'environ 80 dB).
II'est fortement recommandé d'utiliser un volume sonore
moyen (le volume moyen est habituellement inférieur a
2/3 du volume maximal).

Si vous ressentez des bourdonnements dans les
oreilles, réduisez le volume ou n'utilisez plus
I'écouteur ou le casque.

Pour éviter tout risque d'acci laroute

Nutilisez pas I'écouteur lorsque vous conduisez une
bicyclette, une automobile ou une motocyclette.

Dans le cas contraire, vous risqueriez de provoguer un
accident grave. En outre, son utilisation est interdite par
la loi dans certaines régions. L'utilisation de I'écouteur sur
la rue, particuliérement sur les passages pour piétons,
pourrait entrainer des accidents graves.

Pour votre propre sécurité, assurez-vous que le cable de
I'écouteur n'entrave pas vos mouvements ou ne
s'accroche pas dans des objets environnants lorsque
vous faites de I'exercice ou lorsque vous vous promenez.



A ATTENTION Failure to follow all instructions lead to physical injuries or damage to the player.

Utilisation de I'appareil
Gestion des données importantes Evitez de causer des dysfonctionnements

Evitez de causer des dysfonctionnements

Veillez a toujours
enregistrer vos données les
plus importantes

Notez bien que nous ne saurons
étre tenus responsables en cas de
perte des données due a une
panne, & une réparation ou a toute
autre cause.

Evitez tout impact brutal sur
I'appareil (ex : chute de
I'appareil). Ne posez pas
d'objets lourds sur
I'appareil.

Empéchez les corps
étrangers ou la poussiére
de pénétrer dans
I'appareil.
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Utilisez toujours les
accessoires fournis ou
approuvés par Samsung.

Evitez de projeter de I'eau sur
I'appareil. Ne nettoyez jamais
I'appareil a I'aide de produits
chimiques (ex : benzéne ou
diluant) pour ne pas provoquer
d'incendie, de décharge
électrique ou une détérioration
de la surface.

Ne posez jamais I'appareil
pres d'objets émettant des
ondes électromagnétiques
pour ne pas provoquer de
dysfonctionnement.
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Information de base

Composants

| Vérification des accessoires

Lecteur Ecouteurs

Cable USB CD d'installation Cordon de suspension /
Bottier portatif

» L'aspect des accessoires est susceptible d'étre amélioré et modifi€, sans notification préalable.



| Face avant, coté droit et dessus de I'appareil

Tous les touches sont de type ‘a effleurement’.

Affichage a I'écran

Touche Menu

Touche de retour

en arriere

Touche «w < &
Touche Lecture/Pause
et Sélectionner

o(Tome
—

Interrupteur

> Power
(Alimentation) et
Hold (Maintien)
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Information de base

Composants (suite)

| Face arriére/Arriere

, Portuss o s

Port de
connexion

. des écouteurs i
[Face arriere] [Arriere] v

Trou de
réinitialisation

Branchement des écouteurs R

» Face arriere

»

Ecouteurs



Information de base

Screen Display Information

| Musique

~o0r, Normal

1.Lifeis cool

002/020 00:02:20
1 Affichage de la répétition de la lecture 6 Affichage de I'alarme
2 Egaliseur 7 Affichage de I'état de la batterie
3 Renseignements sur la musique 8 Affichage de la durée de lecture
4 Barre d'état de la lecture 9 Affichage de I'état Lecture/Pause
5 Affichage du numéro de la plage en

cours/du nombre total de pistes

”
= Les représentations a I'écran figurent a titre indicatif uniquement. L'écran réel de votre appareil peut
REVARQUE étre différent.




Information de base

Fonctions des touches

Fonctions et utilisation

O[[Hotpr] |

)

Faites glisser dans le sens opposé & celui indiqué par la fléche pour
allumer/éteindre I'appareil.
Faites glisser dans le sens indiqué par la fleche pour verrouiller les touches.

Appuyez longuement pour vous déplacer vers le menu principal.
Tapez rapidement pour vous déplacer vers I'écran précédent.

Déplacement vers le haut, vers le bas, sur la gauche, sur la droite et
sélection des fonctions.

Tapez pour vous déplacer d'une sélection vers le haut ou vers le bas.

Tapez pour vous déplacer d'une sélection sur la gauche ou sur la
droite.

Appuyez longuement pour vous déplacer continuellement vers le
haut ou vers le bas.

Q Tapez rapidement pour sélectionner lecture/pause et la fonction, ou
pour vous déplacer vers I'écran suivant.

Recherche d'une piste et controle du volume en écoute de musique.
& Appuyez longuement sur la touche pour balayer vers un point sur
la piste en cours.

Tapez pour vous déplacer sur la piste précédente ou pour
lancer la lecture de la piste actuelle depuis le début.

Appuyez longuement sur la touche pour balayer vers un point sur
la piste en cours.

Appuyez légerement dessus pour aller a la plage suivante.
“ Tapez pour augmenter/diminuer le volume.

= Tapez pour afficher le menu des options.



0Tapez sur I’écran tactile du bout
des doigts.

= Nutilisez jamais d'objet pointu autre que le bout de vos doigts pour manipuler I'écran tactile.

ameNtioy Sinon, vous risquez de 'endommager.
= Ne tapez sur pas sur I'écran tactile avec des doigts sales.
» Ne toquez pas I'écran tactile avec des gants. Sans quoi, la touche ne fonctionnera pas.

FRA
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Information de base

Consignes de sécurité relatives au chargeur de batterie

RISQUE DE CHOC ELECTRIQUE. NE PAS OUVRIR

Les piéces non isolées contenues dans le
chargeur peuvent provoquer un choc électrique.
Pour votre sécurité, n‘ouvrez pas le boitier du
chargeur.

Lisez ce Manuel de I'utilisateur afin de prévenir
tout probleme pouvant survenir lors de I'utilisation
de ce chargeur.

> >

f = Nutilisez pas le chargeur a proximité d'une source d'eau afin d'éviter tout risque d'incendie ou de
AERTSSENENT - Choc électrique.

1]

= Afin d'éviter tout risque de choc électrique, n'utilisez le chargeur que sur une prise de courant qui
ATTENTION correspond a la forme de la prise du transformateur.

= Assurez-vous que la fiche du chargeur est complétement insérée dans la prise murale.




Information de base
Chargez la batterie complétement avant d'utiliser

Ch arg em ent d e | a pl Ie le lecteur pour la premiére fois ou lorsqu'il n'a pas

été utilisé depuis longtemps.

FRA

Un chargeur est fourni avec votre lecteur.
Branchez le chargeur dans une prise murale.
= Duée de charge : environ 4 h.

Afin d'éviter tout risque d'incendie, ne laissez pas la batterie se recharger plus de 12 heures.

Ne branchez pas plusieurs appareils sur la méme prise murale.

N'utilisez pas un chargeur défectueux.

Lorsque vous utilisez une batterie rechargeable pour la premiére fois ou lorsque celle-ci n'a pas
servi pendant plusieurs mois, commencez par la recharger complétement.

Une surcharge risque de réduire la durée de vie de votre batterie.

La batterie rechargeable est un consommable et sa capacité va diminuer progressivement.

Afin de prolonger la durée de vie de votre batterie, utilisez la batterie entiérement rechargée
jusqu'a ce qu'elle soit entierement déchargée puis rechargez-la de nouveau complétement avant
de la réutiliser.

Veuillez noter que nous déclinons toute responsabilité pour les dommages liés a la perte de
données enregistrées ou sauvegardées suite & une panne, une réparation ou & toute autre cause.
Cela risquerait de provoquer un incendie ou un choc électrique.

= Ne touchez jamais le chargeur si vous avez les mains mouillées.

ATTENTION

Une fois que le lecteur est branché a l'aide du cable USB, le temps nécessaire a un chargement

complet est d'environ quatre heures; ce temps peut varier en fonction de I'environnement installé

REVARQE sur r'ordinateur.

Comme pour tout autre produit de consommation, la durée de vie de la pile diminue progressivement 13
avec le temps.




14

Information de base

Utilisation de base

| Mise sous et hors tension de |'appareil

sun. Norml ~1| Mise sous tension de I'appareil

Faites glisser I'interrupteur [ HOLD »] dans le sens opposé a
la fleche et retenez-le.

« L'appareil sallume.

Mise hors tension de I'appareil

i Faites glisser de nouveau I'interrupteur [ HOLD »] dans le
w0220 sens opposé a la fleche et retenez-le.

= L'appareil séteint.

ﬁ » L'appareil s'éteint automatiquement lorsque aucun des touches n'est actionné pendant une durée
REVARQUE prédéfinie (par défaut : 1 minute) en mode Pause (Pause). » Page 46

| Lire des fichiers musicaux

SSlLILL (m 1 Appuyez longuement sur [ " ] et retenez-la pour vous
déplacer vers le menu principal.

2 Tapez sur [ < *] pour sélectionner <Music> (Musique),
puis tapez sur [O)].

= Le menu de musique s'affiche.

) 3 Utilisez [ =~ =] et [ O] pour sélectionner le fichier musical
souhaité.

4 Tapez sur [ O)].

= La lecture du fichier musical débute.

= Tapez sur [ D ] pour vous déplacer vers I'écran précédent.
REIARQUE = Appuyez longuement sur [ * ] pour vous déplacer vers 'écran du menu principal.




| Réglage du volume

(] | Tapezsur[ O].
= La barre d'état du volume s'affiche.

= Appuyez sur la touche [ ] pour augmenter le volume ou sur la touche [ =]
pour le diminuer.

1.Lifeis cool

0020020 »00:02:20

| Fonction Lock (Verrouillage)

san. Normal "1 En mode Hold, tous les touches sont désactivés. Vous apprécierez
particulierement le c6té pratique de cette fonction lors de vos
marches ou de vos courses a pied.

1 Faites glisser I'interrupteur [ HOLD »] dans le sens de la
fleche et retenez-le.

»00:02.20

2 Faites glisser I'interrupteur [ HOLD »] dans le sens opposé a
la fleche pour désactiver la fonction de verrouillage.

15
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Information de base

Utilisation de base (suite)

| Fonction Reset (Réinitialisation)

Si un dysfonctionnement de I'appareil
survient, vous pouvez réinitialiser le
systéme en appuyant sur le trou de

T ek réinitialisation.

A Appuyez sur la touche Reset situé sur la
partie inférieure de I'appareil & I'aide d'un

RESET objet pointu, comme une un trombone.
N = Le systéme est réinitialisé.
= Cela n'affecte pas vos réglages ou vos
fichiers.




Chargement de vos fichiers préférés
H H H Utilisez Media Studio pour
Installation de Media Studio de Samsung . erer dee fonere
musicaux depuis votre
ordinateur vers le lecteur.

= Installez le programme sur un ordinateur fonctionnant sous Windows XP aprés vous étre connecté
ey &0 tant qu'administrateur. Veuillez vous reporter au manuel d'utilisation de I'ordinateur pour savoir
| comment vous connecter en tant qu'administrateur.

Insérez le CD d'installation fourni avec le lecteur dans le lecteur de CD-ROM
de votre ordinateur.

1 Cliquez sur <Install now>
(Installer maintenant).

2 Cliquez sur <NEXT> (SUIVANT).
= Linstallation de Media Studio est lancée.

« Une icone £ est créée sur votre bureau a la
3 fin de linstallation et Media Studio est lancé.

The setup program stars copying program fes using the.
following information.

Cick [CUSTOM] to instal ater setup instalation setings o click
INEXT]to st copying fles wih the cunent settings.

Curtent Settings:

Instalation Type
uick Instal: Select to instal the Samsung Media Stud
Instalaton Irformation
Folder lo Install D:\Program Files\SamsungS msung
Program Folder ‘Samsung Media Studo 5

Gracenale Tems of Use

This applcation contai n
[You agres that you wil Lo
(You sgres that your nd n
The Gracenate Servic| i v
am )

custom || NExT Cancel

FRA
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Chargement de vos fichiers préférés

Branchement a votre PC

Utilisez le cable USB fourni pour brancher I'appareil sur I'ordinateur.

1 Branchez le cable USB au port USB ( ‘I/) de votre ordinateur.

2 Branchez I'autre extrémité du cable USB sur le fiche USB situé dans la partie
inférieure du lecteur.



| Configuration requise

FRA

Votre systeme d’ordinateur doit satisfaire les caractéristiques suivantes :

= Pentium 300 MHz ou plus = Windows XP Service Pack 2 ou ultérieur
= DirectX 9.0 ou version ultérieure « Port USB 2.0

= 100 Mo d'espace libre sur le disque dur = Lecteur de CD-Rom (2X ou plus)

= Windows Media Player 10,0 ou ultérieur = Résolution 1024 X 768 ou plus

= Sivous branchez le lecteur via un concentrateur USB, la connexion risque d'étre instable.

ATTENTION Veuillez brancher le lecteur directement a 'ordinateur.

= Sivous raccordez le lecteur a votre ordinateur lorsque la pile est faible, le lecteur vérifie automa-
tiqguement I'état de la pile et elle se recharge pendant plusieurs minutes avant que la connexion a
votre ordinateur ne s’effectue.
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Chargement de vos fichiers préférés

Ajout de fichiers/dossiers dans Media Studio
de Samsung

Media Studio vous permet de sélectionner et de répartir vos fichiers et dossiers en
prévision du transfert vers votre lecteur.

SAMSUNG MedoSiudie (=ness ~ —

e @@ ED
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| =L 1 28645 | 16 £3 NewFolder

L O]

{6%) selecrad Fies: 1, Torsl Fies: 10 @ Add Falder I < Addd File.

3 [= add Folder L\j}: addFile |3———— =
1

Veuillez vous reporter a la section Aide pour obtenir plus d'informations sur
l'utilisation de Media Studio.

» Cliquez sur <MENU> (MENU) O <Help> (Aide) [ <Help> (Aide) dans le menu au haut du programme
Media Studio.



= Raccordez le lecteur a votre ordinateur.
= Media Studio doit étre installé sur 'ordinateur.

1 Media Studio démarre automatiquement lorsque vous branchez le lecteur sur
votre ordinateur.

» Sile programme ne démarre pas automatiquement, double-cliquez sur l'icone Media Studio située
sur le bureau.

FRA

2 Cliguez sur I'icdne du fichier souhaité situé a gauche.
. Choisissez le type de fichier que vous souhaitez transférer en cliquant sur I'un de ces icones.

| & représente un fichier musical et | @ représente une photo.

» Cliquez sur licone == pour afficher la liste ETC. La liste ETC comprend d'autres types de fichiers
(ex. : TXT, XOV, ETC) que les fichiers musicaux, photo et vidéo.

| Pour ajouter des dossiers
3 Cliquez sur <Add Folder> (Ajouter un dossier) au

bas de I'écran de Media Studio. linctadng the suoler
» La fenétre Open Folder (Dossier ouvert) apparait.

Di\Dacuments and Settings'siDeskion

3 My Documents
23 My Computer

4 Sélectionnez les dossiers que vous souhaitez & Banrm e

ajouter et cliquez sur <OK> (OK). By —
. . . Z . Z . Z . N 2 Alusers

» Les fichiers du dossier sélectionné sont ajoutés sur la liste a =

s
gauche de I'écran de Media Studio. “#“

™
3

| Pour ajouter des fichiers

3 Cliquez sur <Add File> (Ajouter un fichier) au bas
de I'écran de Media Studio.
= La fenétre Open (Ouvert) apparait.

4 Sélectionnez les fichiers que vous souhaitez ajouter
et cliquez sur <Open> (Ouvrir).

« Les fichiers sélectionnés sont ajoutés sur la liste & gauche de
I'écran de Media Studio. —




Chargement de vos fichiers préférés

Transfert de fichiers vers le lecteur avec
Media Studio de Samsung

Effectuez les étapes suivantes pour transférer les fichiers depuis votre ordinateur
vers le lecteur.

SAMSUNG Medis st

7000 °© i @@
I Bum Ponsble
e oo~ @ s
Garen, e | Theme sty Py Court | Lo — -
C o O e O partatie (P30
= ] Vo
- T R 3 it e
e o e | i T e e
B T3 e 8 T o - e e e
P il - bt |
B G0 o Warm. 1 Hoorn, = . y
# Shepe of my reart ang Ter Summoner's. . ock. P £
H— g il L A S
® When Yo Bebeve Mearish Car, IAFE@OAD, a
7
Fenptre ... ¢
Portable |5 c——me e
(T8 I ] =
(%) Selected Fies: 1, Tokal Fles, 10 (3 add Folder < add File

= La technologie de reconnaissance musicale et les données relatives sont fournies par Gracenote
webRQe et Gracenote CDDB® Music Recognition Service®.

= Le logo et le logotype de Gracenote, le logo et le logotype Gracenote CDDB et le logo “Powered
by Gracenote CDDB" sont des marques déposées de Gracenote. Music Recognition Service et

22 MRS sont des marques de service de Gracenote.




= Raccordez le lecteur a votre ordinateur.
= Media Studio doit étre installé sur 'ordinateur.

1 Media Studio démarre automatiquement lorsque vous branchez le lecteur sur
votre ordinateur.
= Sile programme ne démarre pas automatiquement, double-cliquez sur l'icéne Media Studio située
sur le bureau.

2 Cliquez sur I'icone du fichier souhaité.
. Choisissez le type de fichier que vous souhaitez transférer en cliquant sur I'un de ces icones.

|4  représente un fichier musical et | @ représente une photo.

« Cliquez sur licone =™/ pour afficher la liste ETC. La liste ETC comprend d'autres types de fichiers
(ex. : TXT, XOV, ETC) que les fichiers musicaux, photo et vidéo.

3 Sélectionnez le fichier a transférer sur la liste de gauche.

4 Cliquez sur 'icbne &» .
=« Le fichier sélection est transféré vers le lecteur.

= Ne débranchez pas le cable USB pendant le transfert du fichier sous peine d'endommager le lecteur
arevioy ou Tordinateur.

= Lors du transfert d'un fichier photo vers le lecteur a I'aide de <Media Studio> (Media Studio),

le fichier est converti automatiquement au format JPG avant le transfert. La taille du fichier est

également réglée automatiquement.

= Un fichier photo transféré vers le lecteur sans <Media Studio> (Media Studio) peut étre
différent de la source lors de son affichage sur I'écran du lecteur.

FRA



Ecouter de la musique

Ecouter de la musique

A\l elendalie il Branchez les écouteurs, puis allumez le lecteur et vérifiez la batterie.

EXx. : lecture par artiste
e P

1 Appuyez longuement sur [ 2 ] et retenez-la
pour vous déplacer vers le menu principal.

2 Tapez sur [ < *] pour sélectionner <Music>
(Musique), puis tapez sur [O)].

= Le menu de musique s'affiche.

Music s s«

OIESIC .

Menu Music (Musique)

<Now Playing> (En lecture) : permet de voir la chanson
1 actuelle.

<Artists> (Artistes) : pour effectuer une lecture par artiste
<Albums> (Albums) : pour effectuer une lecture par album

<Tracks> (Pistes) : pour effectuer une lecture par ordre
——l [ numérique ou alphabétique

<Genres> (Genres) : pour effectuer une lecture par genre

=== 2 3 <Playlists> (Listes de lecture) : pour effectuer une lecture par
N y liste de lecture

3 Tapez sur [ < *] pour sélectionner <Artists>
(Artistes), puis tapez sur [D].

= Les fichiers musicaux compatibles avec le lecteur sont aux formats MP3 et WMA.
REVARQLE " Les fichiers MP1 ou MP2 possédant uniquement une extension modifiée vers MP3 peuvent ne pas étre lus.

24
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Music

® Now Playing

5

<
Tapez sur [ «~ = ] pour sélectionner un artiste,
puis tapez sur [D].
= Les albums de l'artiste apparaissent.

Tapez sur [ «~ = ] pour sélectionner un album,
puis tapez sur [(D].

= Les fichiers musicaux de I'album sélectionné
apparaissent.

Tapez sur [ «~ = ] pour sélectionner un fichier
musical, puis tapez sur [(].
» La lecture de la musique démarre.

25
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E;outer de la musique

Ecouter de la musique (suite)

| Mode Pause (Pause)

1 Tapez sur [ (O] lorsque la lecture de la musique est en cours.
= La lecture de la musique est interrompue.

2 Tapez sur [ ()] une nouvelle fois.
= La lecture reprend a I'endroit ou vous I'avez suspendue.

= L'écran s'éteint automatiquement lorsque aucune des touches n'est actionnée pendant une durée
" prédéfinie (par défaut : 1 minute) en mode pause. Vous pouvez régler la période avant I'extinction de
FEARQE pgcran, » Page 46

| Pour effectuer une recherche a l'intérieur d'une plage

1 Appuyez longuement sur la touche [ < * ] pendant que la plage sélectionnée est
en cours de lecture.

= Ces touches permettent d'effectuer la recherche vers le début ou la fin de la plage.

2 Relachez la touche dés que vous souhaitez reprendre la lecture.
= La lecture reprend au point ot vous avez relaché la touche.



| Lecture de la plage en cours & partir du début

Tapez sur [ < ] aprés 3 secondes de lecture.

= La plage en cours est lue a partir du début.

| Lecture de la plage précédente/suivante

Tapez sur [ < ] dans les 3 premiéres secondes de lecture.
» La lecture de la plage précédente démarre.

Tapez sur [ » 1.

= La lecture de la plage suivante démarre.

= Pendant la lecture de fichiers VBR, la plage précédente peut ne pas étre lue méme si vous appuyez
ATTENTION sur la touche [ < ] dans les 3 premiéres secondes de lecture.

27
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Ecouter de la musique

Créér une liste de lecture avec Media Studio de
Samsung

Une Liste de lecture est une liste de vos pieces musicales préférées.

[Samsuns Wi s T
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Cliquez sur la touche <My Album> (Mon album) au haut de Media Studio.
= La fenétre <My Album> (Mon album) apparait.

2 Cliquez sur la touche <New Album> (Nouvel album) au bas de I'écran.
= La fenétre Creation (Création) apparait.

3 Tapez le titre de I'album et cliquez sur <OK> (OK).

= Un nouvel album (liste de lecture) est créé et enregistré dans la section My Album (Mon album)
de Media Studio.



| Ajout de fichiers musicaux sur une Liste le lecture

1

Cliquez sur la touche <My PC> (Mon ordinateur)
au haut de Media Studio.

» La fenétre <My PC> (Mon ordinateur) apparait.
Cliquez sur la touche <My Album> (Mon
album) dans le coin droit de la fenétre.

= La fenétre Album (Album) apparait.

Cliquez deux fois sur I'album souhaité dans la
fenétre de droite.

Sélectionnez les fichiers que vous souhaitez
transférer dans la fenétre <My PC>
(Mon ordinateur).

Cliquez sur l'icone 'y .

» Les fichiers sélectionnés sont ajoutés a I'album (liste
de lecture).

| Exporter une liste de lecture vers votre lecteur & I'aide de Media Studio

Cliquez sur la touche <My Album> (Mon album)
au haut de Media Studio.

» La fenétre <My Album> (Mon album) apparait.
Cliquez sur la touche <Portable> (Portable)
dans le coin droit de la fenétre.

= La fenétre <Portable> (Portable) apparait.
Sélectionnez I'album souhaité sur la liste <My
Album> (Mon album).

Cliquez sur l'icone &y .

= L'album sélectionné est transféré sur le lecteur et
enregistré dans <Music> (Musique) U <Playlists>
(Listes de lecture).

FRA

29



Ecouter de la musique

Pour lire une liste de lecture

N\l el S oAy Reportez-vous aux pages 28 et 29 pour plus de détails sur la création et le
transfert de listes de lecture sur votre lecteur.

1 Appuyez longuement sur [ "] et retenez-la pour vous
déplacer vers le menu principal.

2 Tapez sur [ < *] pour sélectionner <Music> (Musique),
puis tapez sur [O)].

« Le menu de musique s'affiche.

o Playlists

3 Tapez sur [ -~ =] pour sélectionner <Playlists> (Listes de
lecture), puis tapez sur [(OD].
= Le dossier Playlists apparait.

« Si une liste de lecture n'est pas trouvée, le message <No File> (Aucun
fichier) s’affiche a I'écran.

4 Tapez sur [ -~ == ] pour sélectionner le dossier de votre choix,
puis tapez sur [O)].

= Les fichiers musicaux enregistrés dans la liste de lecture sélectionnée
apparaissent.

5 Tapez sur [ -~ =] pour sélectionner un fichier musical, puis
tapez sur [O)].

= Lalecture du fichier musical démarre.



Ecouter de la musique

Utilisation du menu option de musique
| Pour sélectionner un effet sonore

Vous pouvez sélectionner des effets sonores variés ; ils vous permettent de rehausser la musique que vous écoutez.

S am 1 Tapez sur [ @] tout en écoutant la musique.
= Le menu des options de musique apparait.
2 Tapez sur [ « =] pour sélectionner <Sound Effect> (Effets

Sonores), puis tapez sur [)].
= Le menu des effets sonores apparait.

® Sound Effect

3 Tapez sur [ -~ =] pour sélectionner I'effet sonore souhaité,

puis tapez sur [ ].

= Vous pouvez sélectionner entre <Normal>, <Studio>, <Rock>,
<Classical>, <Jazz>, <Ballad>, <Club>, <R&B>, <Dance>,
<Concert Hall> (Salle concert) ou <User> (Utilisateur).

Réglage de I'effet sonore 3D et des basses fréguences

Vous pouvez régler I'effet sonore 3D et I'amplification des basses fréquences.

1 Tapez sur [ « =] pour sélectionner <User> (Utilisateur),
puis tapez sur [O].
= Le menu User (Utilisateur) s'affiche.

2 Tapez sur [ « = ] pour sélectionner <3D&BASS>
(3D&BASSES), puis tapez sur [].
= Le menu de réglage de I'effet sonore 3D et des basses fréquences apparait.

3 Tapez sur [ % *] pour vous déplacer soit sur <3D> ou sur
<BASS> (BASSES). Tapez sur [ «~ =] pour sélectionner le
réglage souhaité, puis tapez ensuite sur [ ].

= Vous pouvez sélectionner un niveau de 0 & 4 pour l'effet sonore <3D> et <Bass> (Basses).
4 » La fenétre de confirmation apparait.

Tapez sur [ % *] pour sélectionner <Yes> (Oui) ou <No> (Non),
puis tapez sur [ ].

= Le réglage est terminé.

FRA
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Ecouter de la musique

Utilisation du menu option de musique (suite)

Réglage de I'égaliseur EQ

Vous pouvez ajuster des fréquences individuelles pour régler le son selon vos
préférences.

1 Tapez sur [ «~ =] pour sélectionner <User> (Utilisateur),

puis tapez sur [(D].
= Le menu User (Utilisateur) s'affiche.

2 Tapez sur [ -~ = ] pour sélectionner <EQ>, puis tapez sur
(O]

« Le menu de réglage de I'égaliseur EQ s'affiche.

3 Tapez sur [ < *] pour sélectionner la fréquence souhaitée.
Tapez sur [ «~ =] pour régler le niveau de la fréquence
sélectionnée, puis tapez sur [D)].
= L'égaliseur <EQ> vous permet d'ajuster la fréquence de -10 a +10.
= La fenétre de confirmation apparait.

4 Tapez sur [ % *] pour sélectionner <Yes> (Oui) ou <No> (Non),

puis tapez sur [ ].
« Le réglage est terminé.



| Pour sélectionner I'affichage de I’égaliseur graphique EQ

N0, Normal

® Graphic EQ

71
2

3

Tapez sur [ @] tout en écoutant la musique.

= Le menu des options de musique apparait.

FRA

Tapez sur [ «~ = ] pour sélectionner <Graphic EQ> (EQ
Graphique), puis tapez sur [(D].
= Le menu de I'égaliseur graphique apparait.

Tapez sur [ «~ = ] pour sélectionner <On> (Activé) ou <Off>
(Désactivé), puis tapez sur [ ].

= <On> (Activé) : I'égaliseur graphique s'affiche a I'écran.
= <Off> (Désactivé) : I'égaliseur graphique ne s'affiche pas a I'écran.

| Pour sélectionner le Mode lecture

NOR. Normal

® Play Mode

1
2

3

Tapez sur [ @] tout en écoutant la musique.

= Le menu des options de musique apparait.

Tapez sur [ «~ =] pour sélectionner <Play Mode>
(Mode lecture), puis tapez sur [)].
= Le menu du Mode lecture apparait.

Tapez sur [ <~ =] pour sélectionner le mode souhaité, puis
tapez sur [O)].

= Vous pouvez sélectionner <Normal> (Normal) <Repeat One> (Répéter
une fois) <Repeat> (Répéter) ou <Shuffle> (Aléatoire).

<Normal> (Normal) : lecture ponctuelle et dans I'ordre de toutes les pistes.

<Repeat One> (Répéter une fois) : répétition ponctuelle d'un fichier.

<Repeat> (Répéter) : répétition de tous les fichiers (lecture en boucle).

<Shuffle> (Aléatoire) : lecture aléatoire des fichiers. 33
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Affichage de I'image

Affichage de lI'image

Avant de démarrer!

Reportez-vous aux pages 22 et 23 pour le transfert des photos sur votre
lecteur.

Ve

++ Photo «

~

L J

= Les vignettes des photos

s'affichent si l'information

REMARQUE

appropriée est comprise
dans le fichier.

Les fichiers ne contenant
pas d'information affichent

plutdt [g@].

1 Appuyez longuement sur [ ] et retenez-la
pour vous déplacer vers le menu principal.

2 Tapez sur [ % *] pour sélectionner <Music>
(Musique), puis tapez sur [O)].
= Laliste de photos apparait.

3 Tapez sur [ «~ = < =] pour sélectionner le
fichier photo souhaité, puis tapez sur [(O)].
= Le fichier sélectionné apparait.

« L'affichage des images de grande taille nécessite
plus de temps.

| Affichage du diaporama

Vous pouvez visionner vos fichiers photo en
diaporama.

Tapez sur [(0)] en mode de visionnement de
photo.
= Le diaporama démarre.

Tapez sur [ ()] our mettre fin au diaporama.

| Pour visionner la photo précédente/suivante

Tapez sur [ O)].
=« La photo précédente ou suivante s'affiche a I'écran.



Affichage de I'image

Utilisation du menu option de photo

| Pour écouter la musique en regardant vos photos
Vous pouvez écouter la derniere chanson lue tout en regardant votre photo.

FRA

{ 1 Tapez sur [ @ ] en regardant la photo.

= Le menu des options de photos apparait.

2 Tapez sur [ ()] pour sélectionner <Background Music On>
(Musique d’atmosphére activée) ou <Background Music Off>
Add to Screen S.. (Musique d’atmosphere désactivée).

2400 « <Background Music On> (Musique d’atmosphére activée) : vous permet

d'écouter la derniére chanson lue tout en regardant votre photo.
= <Background Music Off> (Musique d’atmosphére désactivée) : aucune
musique d'atmosphére en regardant une photo.

| Pour ajouter une photo sur la liste des économiseurs d’écran

1 Sélectionnez un fichier photo que vous souhaitez ajouter sur
la liste des économiseurs d’écran.

I

2 Tapez sur [ B ] en regardant la photo.

Background Mu.. = Le menu des options de photos apparait.

3 Tapez sur [ «~ =] pour sélectionner <Add to Screen Saver>
(Ajouter & écono. écran), puis tapez sur [()].
= Le fichier photo sélectionné est ajouté sur la liste des économiseurs d'écran.

Zoom

= Sélectionnez <Photo> (Photo) depuis <Settings> (Réglages) — <Display> (Afficher) — <Screen Saver>
REMARQUE (Economiseur d'écran) et la photo sélectionnée s'affiche comme économiseur d'écran. B page 45

= Sivous réglez <Default Set> (Réglage par défaut), I'économiseur d'écran sera remis a <Analog
Clock> (Horloge analogique). 35
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Affichage de I'image

Utilisation du menu option de photo (suite)

| Agrandir une photo

Background Mu..
Add to Screen S..

1 Tapez sur [ @ ] en regardant la photo.

» Le menu des options de photos apparait.

2 Tapez sur [ «~ = ] pour sélectionner <Zoom> (Zoom), puis
tapez sur [(D].
» Le menu Zoom Setting (Réglage du zoom) apparait.

3 Tapez sur [ -~ =+ ] pour sélectionner I'échelle souhaitée, puis
tapez sur [(].
» Vous pouvez choisir entre <100%>, <200%> ou <400%>.

4 Tapez sur [ <~ = < ] pour accéder a la partie de la photo que
vous souhaitez agrandir.

5 Pour annuler I'agrandissement, sélectionnez <100%> parmi les
options de zoom, puis tapez sur [{)].

= Cette fonction permet de revenir a la taille initiale.



Ecouter la radio FM

Ecouter la radio FM

A dspkidt ) Branchez les écouteurs, puis allumez le lecteur et vérifiez la batterie.

Ve

« FMRadio, »

~

ATTENTION

1 Appuyez longuement sur [ ] et retenez-la
pour vous déplacer vers le menu principal.

2 Tapez sur [ % *] pour sélectionner <FM Radio>

(Radio FM), puis tapez sur [D].
= La réception de la radio FM est activée.

| Utilisation de la fonction Mute (Muet)

Tapez sur [ ()] tout en écoutant la radio FM.
= Le son est mis en sourdine.
» Tapez sur [ ©)] une fois pour entendre le son de nouveau.

= Branchez toujours vos écouteurs au lecteur lorsque vous recherchez ou réglez les fréquences.
Les écouteurs sont utilisés comme antennes de réception des ondes FM

FRA
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Ecouter la radio FM

Ecouter la radio FM (suite)

| Pour basculer vers le mode manuel
Sélectionnez ce mode si vous souhaitez effectuer une recherche manuelle d'une
fréquence a la fois sur la bande FM.

Preset Mode

1 Tapez sur [ B8] en <Preset Mode> (Mode présélection).

 Go to Manual .. 2 Tapez sur [ «~ = ] pour sélectionner <Go to Manual Mode>
(Aller au mode manuel), puis tapez sur [)].
» <Manual Mode> (Mode manuel) s'affiche.

| Pour basculer vers le Mode présélection

Sélectionnez ce mode si vous souhaitez effectuer une recherche de vos présélections
FM une a la fois.

RS (m Tapez sur [ 8] en <Manual Mode> (Mode manuel).

(Aller au Mode Présél.), puis tapez sur [(O)].
= <Preset Mode> (Mode présélection) s'affiche.

*® Go to Preset ..

91 .1k 2 Tapez sur [ «~ | pour sélectionner <Go to Preset Mode>

Tapez sur [ % *] pour sélectionner la fréquence présélectionnée.

= Dés que <Preset Mode> (Mode présélection) s'affiche, vous pouvez
sélectionner une fréquence radio et I'écouter.

= Siaucune fréquence n'est présélectionnée, le message <Preset list does not exist.> (Liste présélection
inexistante) s'affiche et le lecteur ne bascule pas en <Preset Mode> (Mode présélection).
REMARQUE . . . . . P . L.
= Sivous réglez <Default Set> (Réglage par défaut), les listes prédéfinies enregistrées sont supprimées.
= Sivous sélectionnez (Preset List) (Liste présélection) dans le menu des options FM, vous pouvez voir les
fréquences présélectionnées.
= Reportez-vous aux pages 40 et 41 pour plus de détails concernant la présélection.




| Pour rechercher automatiquement les fréquences

Manual Mode an

91. 1w

Appuyez longuement sur la touche [ < *] en <Manual Mode>
(Mode manuel).

= La fréquence la plus proche du point ol la touche est relachée est recherchée.

|||||||||||||||||
R

| Pour rechercher manuellement les fréquences

LICCLEED "l Tapez sur [ @] en <Manual Mode> (Mode manuel).

91 1 MH » Change de fréquence a chaque nouvelle pression du touche.
0 z

<)
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Ecouter la radio FM

Rég | ag e d e Ia p rés éI ectl on FM Vous pouvez présélectionner jusqu'a

30 fréquences radio FM.

| Pour présélectionner automatiquement les fréquences

Manualiode w 1 Tapez sur [ 8] en mode FM Radio.

91. 1 whz

2 Tapez sur [ «~ == ] pour sélectionner <Auto Preset>
(Présélection auto.), puis tapez sur [(].
® Auto Preset = La fenétre Auto Preset (Présélection auto) s'ouvre.

3 Tapez sur [ % *] pour sélectionner <Yes> (Oui), puis tapez
sur[O].

= Vous pouvez enregistrer automatiquement jusqu’a 30 présélections.

= Lutilisation de <Auto Preset> (Présélection auto) supprime toutes les présélections précédentes.
REMARQUE

| Pour annuler une opération pendant le réglage

Tapez sur [ < *] pour annuler la balayage automatique.
= Le préréglage automatique est annulé et les fréquences réglées jusque-la sont enregistrées.



| Pour effectuer la présélection manuelle

FRA

Manual Mode Toquez sur [ % *] en <Manual Mode> (Mode manuel) pour

91 1 MHz

sélectionner la fréquence souhaitée.

Tapez sur[ @ 1].
® Add Preset
Tapez sur [ «~ = ] pour sélectionner <Add Preset> (Ajouter

présélection), puis tapez sur [(D].

= La fréquence sélectionnée s'ajoute sur la liste présélection. Un maximum de
30 numéros présélectionnés s'ajoute sur la liste en classement séquentiel.

4 Pour définir un numéro présélectionné comme autre
fréquence, suivez les étapes 1 a 3 ci-dessus.

= Sivous tentez d'ajouter une fréquence déja existante sur la Liste présélections, <This preset already

REVARQUE exists.> (Cette présélection existe déja) s'affiche et elle n'est pas ajoutée.

| Pour rechercher les fréguences en mode Preset (Présélection)

(USEI I Tapezsur[ < *]en <Preset Mode> (Mode présélection).

91 1 = Le numéro préréglé est sélectionné ; vous pouvez alors écouter la
. 1 MHz
A

SR fréquence radio attribuée a ce numéro.

]l <) >

% = Sivous souhaitez vérifier la Liste présélections en <Preset Mode> (Mode présélection), Tapez sur

8 P ) ; PR .
REVARQLE [ ®] pour sélectionner <Preset List> (Liste présélections) et tapez sur [() ] .
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Ecouter la radio FM

Pour supprimer les préeréglages

Delete Preset
® 89.1MHz

Tapez sur [ B ] en <Preset Mode> (Mode présélection).

Tapez sur [ «~ =] pour sélectionner <Delete Preset>
(Supprimer Présél.), puis tapez sur [(D].
= La fréquence présélectionnée s’affiche.

Tapez sur [ «~ ] pour sélectionner la fréquence
présélectionnée a supprimer, puis tapez sur [ ].
= La fenétre de confirmation apparait.

Tapez sur [ < *] pour sélectionner <Yes> (Oui), puis tapez
sur [O].

= Le numéro présélectionné sélectionné est supprimé.

Pour sélectionner et supprimer des numéros
présélectionnés, suivez les étapes 1 & 4 ci-dessus.



Ecouter la radio FM

Réglage de laradio FM

FRA

| Pour régler la réception FM

EmE R 1 Tapez sur [ @] en mode FM Radio.

91. 1wz

2 Tapez sur [ «~ =] pour sélectionner <FM Sensitivity>
(Sensibilité FM), puis tapez sur [(OD)].
® FM Sensitivity » Le menu FM Sensitivity (Sensibilité FM) apparait.

3 Tapez sur [ «~ = ] pour sélectionner la sensibilité, puis tapez
sur[O].

= Vous pouvez choisir entre <High> (Elevée), <Middle> (Moyenne) ou
<Low> (Basse).

= Plus la sensibilité est élevée, plus vous pouvez capter de fréquences.

43



Réglages

CO n fl g u rat | on d e I ' éc [an Vous pouvez régler léconomiseur décran et

I'heure de mise hors tension de I'écran.

1 Appuyez longuement sur [ 2] et retenez-la pour vous déplacer
vers le menu principal.

Tapez sur [ % *] pour sélectionner <Settings> (Réglages),
puis tapez sur [D].

o0 SIS « Le menu Settings (Réglages) apparait.

EETs Tapez sur [ «~ =] pour sélectionner <Display> (Afficheur),
® Display pUiS tapez sur [O]
= Le menu Time (Heure) apparait.

Utilisez les touches [« =] et [(D)] pour régler les fonctions
souhaitées.

Fonctionnement de la touche
Tapez sur [ « = | pour défiler sur la liste.
REMRQE " 1P SUr [ ] pour defi :
= Tapez sur [ ©] pour sélectionner et confirmer vos réglages.

= Tapez sur [ o ] pour retourner a I'écran précédent.

44



<Screen Saver> (Economiseur d’écran) : vous permet de sélectionner une image comme
économiseur d'écran. Sélectionnez entre <Analog Clock> (Heure analogique), <Animation1>
(Animation 1), <Animation2> (Animation 2) <Animation3> (Animation 3), and <Photo> (Photo)
puis réglez la période d'attente. <Photo> (Photo) s'agit d'une photo définie comme économiseur
d'écran dans <Add to Screen Saver> (Ajouter aux économiseurs d'écran). » page 35

Vous pouvez choisir entre <15 sec>, <30 sec>, <1 min>, <3 min>, <5 min>, et <Off> (Désactivé).
Si aucune touche n'est activée durant les périodes indiquées plus haut, le lecteur affiche
I'économiseur d'écran.

<Display Off> (Affichage désactivé) : si aucune touche n’est activée durant les périodes
indiquées plus bas, I'écran s'éteint automatiquement. Vous pouvez choisir entre <15 sec>,

<30 sec>, <1 min>, <3 min>, <5 min>, et <Always On> (Toujours activé). L'afficheur étant éteint,
appuyez sur toute touche pour réactiver I'écran.

1 Tapez sur [ «~ = ] pour sélectionner <Screen Saver>
(Economiseur d'écran), puis tapez sur [(].
= Le menu des économiseurs d'écran apparait.

2 Tapez sur [ «
d’écran souhaitée, puis tapez sur [ *1].

=] pour sélectionner I'image d’économiseur
15sec

3 Tapez sur [ «~ = ] pour sélectionner la période d'attente, puis

tapez sur [ ].
= La fenétre de confirmation apparait.

4 Tapez sur [ % *] pour sélectionner <Yes> (Oui), puis tapez
sur[)].
= Les réglages de I'économiseur d’écran sont complétés.

FRA
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Réglages

Rég | ag e d e I 'h eure Non seulement pouvez-vous régler la date et I'heure, mais

Settings

® Time

aussi le minuteur de mise en veille et I'extinction auto.

1 Appuyez longuement sur [ 2 ] et retenez-la pour vous
déplacer vers le menu principal.

2 Tapez sur [ % *] pour sélectionner <Settings> (Réglages),
puis tapez sur [O)].
« Le menu Settings (Réglages) apparait.

3 Tapez sur [ -~ =+ ] pour sélectionner <Time> (Heure), puis
tapez sur [O)].

= Le menu Time (Heure) apparait.

4 Utilisez les touches [« =] et [ ] pour régler les fonc-
tions souhaitées.

= <Sleep Timer> (Minuteur de mise en veille) : permet d'éteindre automa-
tiquement I'appareil apres I'écoulement de la durée présélectionnée.
Sélectionnez entre <Off> (Désactivé), <15 min >, <30 min>, <60 min>,
<90 min>, ou <120 min>.

<Auto Power Off> (Heure d'arrét automatique) : permet d'éteindre

automatiquement I'appareil lorsque aucun touche n'est actionné avant
I'écoulement de la durée préréglée en mode Pause (Pause). Options

disponibles : <15 Sec> (15 s), <30 Sec> (30 s), <1 Min> (1 min),

<3 Min> (3 min), ou <5 Min> (5 min).

<Time Set> (Réglage de I'heure) : permet de régler I'heure actuelle.
» Page 47



Réglage de I'heure

1 Tapez sur [ «~ =] pour sélectionner <Time set> (Réglage de
I'heure), puis tapez sur [(D)].

2 Toquez [ < *] pour vous déplacer sur <AM/PM, Hour, Minute>
(Avant-midi/Aprés-midi, Heure, Minute) et utilisez[ +~ == ] pour
régler I'heure.

3 Tapez sur [D].

» La fenétre de confirmation apparait.

4 Tapez sur [ % *] pour sélectionner <Yes> (Oui),
puis tapez sur [ ].
= L'heure est enregistrée.
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Réglages

Rég | ag e d e Ia Ian g u e Vous pouvez définir la langue du menu.

Settings

mw 1 Appuyez longuement sur [ "] et retenez-la pour vous
déplacer vers le menu principal.

2 Tapez sur [ < *] pour sélectionner <Settings> (Réglages),
puis tapez sur [(D].
= Le menu Settings (Réglages) apparait.

3 Tapez sur [ -~ == ] pour sélectionner <Language> (Langue),
puis tapez sur [D)].

4 Utilisez [« =] et [(D] pour sélectionner la langue du
menu.

« Options disponibles : <English>, < =01 >, <Francais>, <Deutsch>,
<ltaliano>, < BA:E >, < EitEhX >, < EHPX >, <Espafiol>, < Pycckuii >,
<Magyar>, <Nederlands>, <Polski>, <Portugués>, et <Svenska>.

= Les langues prises en charge peuvent étre modifiées ou ajoutées.
REMARQUE




Réglages

Rég Iag e d u Systém @ Vous pouvez régler plusieurs fonctions du lecteur.

1 Appuyez longuement sur [ *] et retenez-la pour vous

Display déplacer vers le menu principal.
Time 2
Language Tapez sur [ % *] pour sélectionner <Settings> (Réglages),

puis tapez sur [()].
» Le menu Settings (Réglages) apparait.

3 Tapez sur [« = ] pour sélectionner <System> (Systéme),

puis tapez sur [O)].
= Le menu System (Systeme) apparait.

4 Utilisez les touches [ -
fonctions souhaitées.

«] et [(D] pour régler les

<Resume> (Reprise) : permet de définir le point de reprise de la lecture apres avoir terminé I'écoute de
la musique. Sélectionner <On> (Activé) reprend la lecture depuis le dernier point d'arrét tandis que <Off>
(Désactivé) reprend la lecture depuis le début de la derniere écoute de la musique.

<Beep> (Bip sonore) : Permet aux touches d'émettre un son lorsqu'ils sont activés. Options
disponibles : <On> (Activé) ou <Off> (Désactivé).

<Volume Limit> (Limite du volume sonore) : permet d'éviter les blessures aux oreilles en
réglant la limite du volume sonore lorsque vous utilisez les écouteurs. <On> (Activé) limite le
niveau du volume a 20 tandis que <Off> (Désactivé) le limite jusqu’a 30.

<FM Region> (Région FM) : permet de choisir votre région pour la radio FM. Sélectionnez
depuis <Korea/USA> (Corée/E.-U.), <Japan> (Japon) et <Other Countries> (Autres pays).

Bande de fréquences par région
- Corée/Etats-Unis : recherchez des fréquences FM comprises entre 87,5 MHz et 108.0 MHz pour les
lecteurs de 100 kHz.

- Japon : recherchez des fréquences FM comprises entre 76,0 MHz et 108.0 MHz pour les lecteurs de 100 kHz.

- Autres pays : recherchez des fréquences FM comprises entre 87,50 MHz et 108.00 MHz pour les
lecteurs de 50 kHz.

La région FM peut étre supprimée ou modifiée en fonction de la région cible du lecteur.

Si vous modifiez la région FM, les fréquences radio préalablement enregistrées seront supprimées.
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Réglages

Réglage du systéme (suite)

= <Default Set> (Réglage par défaut) : permet de revenir aux valeurs de réglage par défaut.

= <About> (A propos de) : permet de Vérifier la version de micrologiciel, la capacité de mémoire et le
numéro de fichier.

. Firmware Version (Version de micrologiciel) : affiche la version de micrologiciel courante.

. Memory (Mémoire) : indique la capacité restante de la mémoire. <Used> (Utilisée) indique la partie
utilisée, <Remain> (Restante) indique la capacité restante et <Total> (Totale) indique la capacité de
mémoire totale.

. Files (Fichiers) : <Music> (Musique) indique le nombre de fichiers musicaux, <Photo> (Photo) le nombre
de photos et <Total> (Total) le nombre total de fichiers.

Réglage par défaut

| Settngs QW) 1 Tapez sur [ « =] pour sélectionner <Default Set> (Réglages
par défaut), puis tapez sur [(].
= La fenétre de confirmation apparait.

® Default Set 2 Tapez sur [ % *] pour sélectionner <Yes> (Oui), puis
tapez sur [OD].

« <Yes> (Oui) : permet d'initialiser tous les réglages par défaut.

« <No> (Non) : permet d'annuler les réglages par défaut.

= Sivous réglez <Default Set> (Réglage par défaut), toutes les fonctions récupérent leur réglage a l'usine.

REMARQUE w A propos de la mémoire intégrée
La taille de la mémoire intégrée réelle disponible est Iégérement inférieure a celle indiquée, car le
micrologiciel interne en utilise une partie.




Pour mettre a niveau le micrologiciel

FRA

Des mise a niveau peuvent étre disponibles pour ce lecteur afin d’en améliorer la
performance et la compatibilité.

1 Branchez-vous a htp://www.samsung.com, sélectionnez [SUPPORT] -
[DOWNLOAD CENTER] et ensuite, sélectionnez votre appareil.

2 Lorsque la page de I'appareil apparait, sélectionnez [Firmware] sous le nom du
modeéle pour télécharger le tout dernier micrologiciel.

Décompressez le fichier téléchargé sur votre bureau.
= Le fichier décompressé s'affiche.

4 Branchez le lecteur a votre PC a I'aide du cable USB.

Cliquez a droite sur la touche de
démarrage en bas a gauche de I'écran
de votre ordinateur, puis sélectionnez
Explorer pour ouvrir I'explorateur de
Windows sur votre ordinateur.

» [Samsung YP-K3] s'affiche dans

I'explorateur de Windows.
Seard]

Properties

Open All Users
Explore All Users
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Pour mettre a niveau le micrologiciel (suite)

6 Trouvez et cliquez sur I'icone Desktop
; T Bk Ve o Tods e
(Bureau) dans I'explorateur de Windows Qo - © - | D [ e | T
(colonne de gauche). i [ ot .
Fokdrs % iy caments
Le contenu du bureau s'affiche dans la L - B s
colonne de droite. R Brvare ke
6 P LodlOl (O] i rikoba acrobat 6.0 Professinal
et 8 somsung s Sk
s coar S
P Iommr B

Hroreacs.ion
L

o B Semarn W3 f
. i By e

5 8 iy etk s
ol ercuio i

7 Trouvez et sélectionnez les fichiers de mise &
jour du micrologiciel (colonne de droite),
glissez et déplacez-les dans le fichier Data
(Données) de [Samsung YP-K3] - [Data].

Elre

Le lecteur s’éteint automatiquement apres avoir débranché le cable USB.

Appuyez longuement sur I'interrupteur [ « HOLD] dans le sens opposée a la
fleche.

= Le micrologiciel est mis a jour.
= Le lecteur s'éteint automatiquement lorsque la mise a jour est complétée.

©

= Vérifiez 'état de chargement de la pile du lecteur. Si le chargement de la pile est insuffisant,
52 REMARQUE le micrologiciel ne sera pas mis a niveau.




Dé p an n ag e Si un dysfonctionnement survient, vérifiez les points suivants.

Si le probleme persiste, contactez le centre de dépannage Samsung le plus proche.

Probléme Points de contrdle et dépannage

L'appareil ne s'allume pas si la pile est entierement déchargée.
Rechargez la pile et remettez I'appareil sous tension.
Appuyez sur la touche Reset (Réinitialisation).

L'appareil ne s'allume
pas.

Vérifiez si l'interrupteur [HOLD] est dirigé dans le sens de la fleche.
Les touches ne Vérifiez si vous avez appuyé sur le bon touche, puis essayez de

fonctionnent pas. nouveau. b Page 11
Appuyez sur la touche Reset (Réinitialisation).

Si vous sélectionnez <Display Off> (Affich. désactivé) depuis
<Settings> (Réglages) - <Display> (Afficheur), I'écran ACL
, demeure éteint. Tapez sur n'importe quelle touche pour allumer
L'écran ne s'allume pas. I'écran ACL ou vérifiez les réglages de l'afficheur. »page 45

= |l se peut que les données affichées a I'écran ne soient pas
visibles sous les rayons directs du soleil.

Vérifiez I'état du bloc-piles.
L'alimentation se coupe automatiquement lorsque la pile est

L'alimentation est

coupee. entierement déchargée. rechargez la pile.
= Si vous sélectionnez <Auto Power Off> (Extinction auto) dans
<Settings> (Réglages) - <Time> (Heure), 'appareil s'arréte en
mode pause. Allumez le lecteur.
La durée de vie de la » La durée du bloc-piles peut varier en fonction du mode sonore et

des réglages de I'écran.

La durée de vie du bloc-piles peut étre réduite si vous I'exposez a des
températures basses ou élevées pendant des périodes prolongées.

batterie différe de celle
indiquée dans le manuel.

Dysfonctionnement du Vérifiez que la configuration requise de I'ordinateur a été
programme. correctement établie.
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Dépannage (suite)

Probléme Points de contrdle et dépannage

La connexion &
I'ordinateur est
désactivée.

La lecture est
désactivée.

Le téléchargement du
fichier est désactivé.

Des fichiers ou des
données manquent.

Affichage anormal de la
durée de lecture.

L'appareil est chaud.

Appuyez sur le menu Démarrer de la barre d'outil de votre ordinateur
pour lancer la mise a jour Windows. Sélectionnez les mises a jour et
le Service Pack. Ensuite, mettez-les a jour. Redémarrez votre
ordinateur et rebranchez I'appareil.

= Vérifiez que le fichier disponible a bien été enregistré par le lecteur.
= Assurez-vous que le fichier musical n’est pas endommagé.
= Vérifiez que la puissance de la pile est suffisante.

= Vérifiez que le cable USB est correctement branché.
Rebranchez-le au besoin.

= Assurez-vous qu'il reste de I'espace disponible sur la mémoire.

= Appuyez sur la touche Reset (Réinitialisation).

Vérifiez que le cable USB n'a pas été débranché durant le transfert du
fichier ou des données. Si tel est le cas, les fichiers/données mais
également I'appareil risquent d'étre endommagés. Vous devez faire
preuve d'une extréme prudence a cet égard car Samsung ne saurait
en aucun cas étre tenu responsable de la perte des données.

Vérifiez que le fichier est au format VBR (débit binaire variable).

Les phases de chargement peuvent générer de la chaleur. Cela
n'a aucune incidence sur la durée de vie de I'appareil ou sur son
fonctionnement.



A r b O res C e n C e d eS m en u S Cette fonction vous permet de consulter

rapidement la structure du menu.

<
:
Music FM Radio Photo Settings
Display Time Language System
Screen saver Sleep Timer Resume
Display Off Auto Power Off Beep
Time Set Volume Limit
FM Region
Default Set
About
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Caractéristiques du produit

Nom du modéle YP-K3
Alimentation 3,7V (Lithium polymere rechargeable)
Alimentation de la batterie intégrée 500mAh

Fichier Compatibilité

Music : MPEG1/2/2.5 3 couches (8 kbps a 320 kbps, 22 kHz a 48
kHz), WMA(48kbps a 192kbps, 22kHz a 48kHz)

Image : JPEG (ISO/IEC 10918-1/Annexe F — Mode de
fonctionnement séquentiel DCT)

Sortie des écouteurs

20 mW(France 5 mW/CH)(16 Q)

Bande de fréquences de la sortie

20 Hz & 20 KHz

Taux de bruit

88 dB avec filtre passe bas 20 kHz (& partir de 1 KHz, 0 dB)

Durée de lecture

25 heures de musique (fondé sur MP3 a 128 kbps, niveau de
volume & 15 en mode normal)

Plage de températures de fonctionnement

5a35°C

Etui

Inoxydable, plastique

Poids

1,76 oz (500)

Dimensions (L x H x P)

1,73 X 3,78 X 0,27 inches (44 X 96 X 6,95 mm)

Fréquence FM

87,5~108,0MHz

Rapport signal FM 50dB
TH.D. FM 1%
Sensibilité FM utile 38dBu

o Le contenu de ce manuel est susceptible d'étre modifié en vue d’étre amélioré sans

notification préalable.



Caractéristiques du produit

L'unité qui se trouve avec ce manuel de I'utilisateur est fournie sous licence sous
certains droits de propriété intellectuelle de parties tierces. Cette licence est limitée a une
utilisation privée non commerciale par I'utilisateur final pour les contenus sous licence.
Aucun droit n’est concédé pour une utilisation commerciale.

Cette licence ne couvre aucun produit autre que celui-ci et ne peut étre étendue a un
produit ou processus qui n'est pas sous licence selon la norme ISO/IEC 11172-3 ou
ISO/IEC 13818-3 utilisé ou vendu avec ce produit.

La licence couvre uniquement l'utilisation de ce produit pour encoder et/ou décoder

des fichiers audio selon la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.

Aucun droit n’est cédé sous cette licence pour des caractéristiques ou des fonctions

du produit qui ne sont pas conformes & la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.
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Garant|e L|m|tee Samsung

Samsung Electronics Canada Inc. (SECA)
garantit ce produit contre tout défaut de fabrication.

SECA garantit aussi que si cet appareil ne fonctionne pas convenablement durant
la période de garantie et qu'il s'agit d'un défaut de fabrication SECA se réservera le
droit de réparer ou de remplacer I'appareil défectueux.

Toutes les réparations sous garantie doivent étre effectuées par un Centre de
service autorisé SECA. Le nom et 'adresse du Centre de service le plus prés de
chez vous peut étre obtenu en composant sans frais le 1-800-726-7864 ou en
visitant notre site web au www.samsung.ca

Main-d’oeuvre Pieces
un (1) an (au comptoir) un (1) an

Pour tous les modéles portatifs, le transport de I'appareil sera la responsabilité

du client. Le recu de vente original doit étre conservé par le client car cela constitue
sa seule preuve d'achat acceptée. Il doit le présenter au Centre de service agréé au
moment o il fait la demande d'une réparation sous garantie.

Exclusions

Cette garantie ne couvre pas les dommages causés par un accident, un incendie,
une inondation, un cas de force majeure, un mauvais usage ou une tension
incorrecte. La garantie ne couvre pas aussi une mauvaise installation, une
mauvaise réparation, une réparation non autorisée et tout usage commercial ou
dommages survenus durant le transport. Le fini extérieur et intérieur de méme
que les lampes ne sont pas couverts par cette garantie. Les ajustements par le
client qui sont expliqués dans le guide de I'utilisateur ne sont pas couverts en
vertu de cette garantie. Cette garantie sera automatiquement annulée pour tout
appareil qui aurait un numéro de série manquant ou modifié. Cette garantie est
valable seulement sur les apparells achetés et utilisés au Canada.




Si vous avez des suggestions ou des questions concernant les produits Samsung,
veulillez contacter le Service Consommateurs Samsung.

Samsung Electronique Canada Inc., Service a la Clientéle

1-800-SAMSUNG (7267864)
www.samsung.com/ca
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